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Test System Maintenance Software Manual 

The Test System Maintenance Software Manual contains reference information about 
monitoring and performing maintenance operations on components of your test 
system. 

Top Tasks 

What do you want to do? Where to go 

Configure maintenance operations to perform 
on selected components within your test system 
or view recent maintenance history and system 
information. 

Go to the application Home page. 

View a detailed report with the results of 
maintenance operations performed on your test 
system. 

Go to the application Reports page. 

Configure Test System Maintenance Software 
settings. Go to the application Settings page. 

Important Concepts 

What do you want to learn? Where to go 

How to perform maintenance operations on 
selected components within your test system. Maintenance Operations 

How to find test system components or ports 
that are not appearing or behaving as expected 
in Test System Maintenance Software. 

Verify Components 

How to generate a detailed report with the 
results of maintenance operations performed on 
your test system. 

Reports 

How to rename system components to match 
the names originally specified in the test system 
configuration file. 

Renaming Components 
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What do you want to learn? Where to go 

How to configure switch terminal block 
components to match the configurations 
originally specified in the test system 
configuration file. 

Configuring Switch Terminal Blocks and 
Topologies 

How to navigate Test System Maintenance 
Software and change application settings. Environment Reference 

© 2020–2022 National Instruments Corporation. All rights reserved. Refer to the 
<National Instruments>\_Legal Information directory for information 
about NI copyright, patents, trademarks, warranties, product warnings, and export 
compliance. 

Maintenance Operations 

Select the operations you want the Test System Maintenance Software to run by 
clicking the Gear button ( ) in the Home page and checking the boxes of the 
operations you want to perform. 

Verify Components 

The Verify Components operation detects test system components discoverable by 
the Test System Maintenance Software and compares the results to the system 
configuration file to generate a list of test system components. 

The Verify Components operation generates a list of the following: 

• Name changes 
• Missing components 

Note You cannot change the settings in the Run Configurations panel while 
executing operations. Some operations require several minutes to run and 
cannot be canceled while running. The Verify System Configuration 
operation always executes before any other operations. 
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• Components with problems 
• Components not expected but found 
• Missing Ports 
• Ports with problems 
• Ports not expected but found 

Related tasks: 

• Renaming Components 
• Configuring Switch Terminal Blocks and Topologies 

Related reference: 

• COM Port Binding 

Reset 

Use the Reset operation to reset test system components. 

The Reset operation initializes components to the power-on state. Resetting also 
clears the status of a component that exceeded a threshold such as temperature 
operating range. 

Self Test 

Note You must run the Verify Components operation after enabling the 
Renaming Components or Configuring Switch Terminal Blocks and 
Topologies settings before the settings will take effect. 

Note Before running the Reset operation, make sure no other operations are 
running on the test system as the driver may need exclusive access to 
component resources. 

Note This operation is not supported on all devices. 
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Use the Self Test operation to verify baseline functionality of test system components. 
The level of verification varies by component, but minimally, this operation verifies 
that the system controller can communicate with the component. 

Before running the Self Test operation, make sure no other operations are running on 
the test system as the driver may need exclusive access to component resources. 

Self-Calibrate Components 

The Self-Calibrate Components operation performs self-calibration on test system 
instruments by verifying an instrument against an onboard standard and adjusting the 
performance of the instrument to compensate for any discrepancies. 

Typically, you perform self-calibration in the same environment in which you use the 
instrument. By doing so, the self-calibration operation can compensate for factors 
such as ambient temperature and time drift. 

Get Calibration and Temperature Information 

The Get Calibration and Temperature Information operation returns the following 
information for each test system component: 

Note This operation is not supported on all devices. 

Note Before running the Self-Calibrate Components operation, make sure 
no other operations are running on the test system as the driver may need 
exclusive access to instrument resources. 

Note This operation is not supported on all devices. 

Note This operation is not supported on all devices. Some devices may not 
support all the information listed below. For example, PXI controllers can 
report current temperature, but cannot provide calibration information. 
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• External Calibration Date—The date of the most recent external calibration. 
• External Calibration Temperatures—The temperature of the most recent external 

calibration. 
• Recommended External Calibration Interval—The recommended period between 

external calibrations. 
• Self-Calibration Date and Time—The date and time of the most recent self-

calibration. 
• Self-Calibration Temperatures—The temperature of the most recent self-

calibration. 
• Current Temperatures—The current component temperature. 

A blank entry in the table indicates that the component does not provide that data. 

Check Continuity 

The Check Continuity operation ensures all components that shipped with the test 
system are correctly routed to their assigned pins in the mass interconnect. When 
running this operation, Test System Maintenance Software prompts you to connect an 
FDT. 

Renaming Components 

Component names must match those present in your system configuration file. Test 
System Maintenance Software operations may not run properly if the names do not 
match. For example, if you reset the NI MAX database or manually change a resource 
name or alias from the default NI designated name, Test System Maintenance Software 
may not recognize a component. The Renaming Components setting ensures test 
system component names match the names specified in the system configuration file. 
You must run the Verify Components operation after enabling this setting for the 
changes to take effect. 

Complete the following steps to enable Renaming Components. 

1. Go to the Settings page in Test System Maintenance Software and click the 
Renaming Components checkbox. 

2. Run the Verify Components operation to automatically rename and detect test 
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system components. 

Related concepts: 

• Verify Components 

Configuring Switch Terminal Blocks and Topologies 

Switch terminal blocks delivered with NI systems are configured to associate with the 
switch modules specified in the system design. Some NI switch terminal blocks used 
with NI PXI switches cannot be detected by software. For example, the TB-2640B 
switch terminal block used with the PXIe-2532B switch module cannot be detected by 
software. Test System Maintenance Software may not operate correctly if you alter the 
configurations of these undetectable switch terminal blocks in NI MAX. Enabling 
Configuring Switch Terminal Blocks and Topologies ensures that the configuration of 
these switch terminal blocks matches the original system design. 

Note This setting only applies to the following switch terminal blocks that 
cannot be detected by software, which are associated with the PXIe-2532B 
device. If your system does not contain any of the following switch terminal 
blocks, you do not need to enable this setting, 

• TB-2640B 
• TB-2641B 
• TB-2642B 
• TB-2643B 
• TB-2644B 
• TB-2645B 
• TB-2646B 

Note Continuity tests for the PXIe-2532B will result in a failure when the 
topology of the switch terminal block does not match that of the switch 
terminal block specified in the original system design. 
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When you enable the Configuring Switch Terminal Blocks and Topologies setting, 
Test System Maintenance Software restores the switch terminal block to the 
configuration originally specified in the system design in NI MAX. To enable this setting, 
complete the following steps. 

1. Go to the Settings page in Test System Maintenance Software and click the 
Configuring Switch Terminal Blocks and Topologies checkbox. 

2. Run the Verify Components operation to verify that Test System Maintenance 
Software detects the terminal switch block. 

Related concepts: 

• Verify Components 

Terminal Block Topologies 

Some NI switch terminal blocks support both 1-wire and 2-wire topologies. Read the 
following to learn more about using switch terminal blocks with Test System 
Maintenance Software. 

Supported Topologies for NI Switch Terminal Blocks 

The following table shows the supported topologies for NI switch terminal blocks 
designed for use with the PXIe-2532B switch matrix device. 

Switch terminal block name Supports 1-wire topology Supports 2-wire topology 

TB-2640B Yes No 

Note You must run the Verify Components operation after enabling this 
setting for the changes to take effect. 

Note When viewing the following switch matrix modules and switch 
terminal blocks in NI software, the "B" does not appear in the device name. 
For example, if you are using a TB-2646B switch terminal block in your 
system, it appears as a TB-2646 switch terminal block when viewed in NI 
MAX. 
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Switch terminal block name Supports 1-wire topology Supports 2-wire topology 

TB-2641B Yes No 

TB-2642B Yes No 

TB-2643B Yes Yes 

TB-2644B Yes Yes 

TB-2645B Yes Yes 

TB-2646B Yes Yes 

Running Verify Components Operations 

If you enable the Configuring Switch Terminal Block Topologies setting in Test System 
Maintenance Software and run the Verify Components operation, Test System 
Maintenance Software will do one of the following for each switch terminal block in 
your system: 

• If the switch terminal block type matches the switch terminal block type specified 
in the original system design, Test System Maintenance Software will not change 
the switch terminal block topology. For example, if you deliberately set a switch 
terminal block to use a 2-wire topology in NI MAX, Test System Maintenance 
Software will not change this configuration while running Verify Components with 
Configuring Switch Terminal Block Topologies enabled if the switch terminal 
block is the appropriate type to use with the associated switch device. 

• If an incorrect switch terminal block type is configured in NI MAX, or if no switch 
terminal block type is configured, Test System Maintenance Software will configure 
the switch terminal block selected when the system was designed, and configure 
the switch terminal block to use a 1-wire topology. 

Running Continuity Test Operations 

Continuity tests for the PXIe-2532B will result in a failure when the topology of the 
switch terminal block does not match the topology specified in the original system 
design for that switch terminal block. 

Note If you need to use a 2-wire topology for a switch terminal block, 
you must configure this setting in NI MAX. 
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Reports 

The Test System Maintenance Software generates a report containing information 
about the test system each time you run operations. 

The generated report displays information from the operations selected in the Home 
page. To view the most recent report, and a list of previous reports, go to the Reports 
page. You can configure the number of reports Test System Maintenance Software 
stores in the Settings page. 

The report contains the following information: 

• Overall Status—Outcome of the maintenance operations, including information 
about operations that failed. 

• General Information—Table listing report start and end date, as well as the system 
configuration name, model name, part number, serial number, and system tag. 

• System Configuration Verification Summary—Results of the Verify System 
Configuration operation. 

• System Components — General Information—Table listing the hardware present 
in the test system, as well as the hardware's name, part number, serial number, 
firmware version, and location in the test system. 

• System Ports — General Information—Table listing the ports present in the test 
system, as well as the port name, type, and location in the test system. 

• System Components — Operations Performed—Table detailing the operations 
executed on each component and the component's status. Reported values 
include the following: 

• Passed—The test for this component passed. 
• Failed—The test for this component failed. Refer to the report footnote for 

additional details. 
• N/A—The operation is not supported for this component. 

Note The default value of saved reports is 15,000. 

Note Report file names are formatted specifically by Test System 
Maintenance Software. Changing report file names will result in inaccessible 
reports or misrepresentation of available reports. 
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• System Components — Calibration Information and Current 
Temperatures—Table detailing the external calibration date, external calibration 
temperature, recommended external calibration interval, self-calibration date and 
time, self-calibration temperatures, and current temperatures. 

COM Port Binding 

Configure COM port bindings to be consistent with your system design. 

Test System Maintenance Software detects errors in your system configuration, 
including incorrect COM port binding assignments. The Verify System Configuration 
operation checks whether your COM port bindings match your system configuration 
file. 

After running the operation, check for errors in the generated report. If a COM port in 
the system has a port number that does not match the system definition, Test System 
Maintenance Software will log the following error under the Ports with Problems 
section of the report: 
The serial port binding, COM{#}, does not match the serial port binding from the 

system definition, COM{#}. 

Automatic adjustment of serial port bindings is not supported. 

See the help file for details on how to manually modify serial port bindings. 

Refer to the following topics for instructions on how to correctly configure COM port 
bindings to resolve these errors: 

• PXI Controller COM Port Binding 
• NI Serial Module COM Port Bindings 

Related concepts: 

• Verify Components 

PXI Controller COM Port Binding 

Note If you need to assign a COM port binding to a port already in use, make 
temporary assignments to an unused COM port. 
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Configure PXI Controller COM ports to be consistent with your system design if the 
System Verification operations reports a COM port number assignment error. Read the 
following instructions for information on how to correctly assign a PXI controller port 
number. 

1. Open Windows Device Manager. 
2. Select Ports » Communications Port, and right-click to select Properties. 
3. Click Advanced... and select a port binding from the COM Port Number drop-down 

list. 

After configuring new port bindings, close the Properties window, right-click the 
Communications Port in Windows Device Manager, and select Scan for Hardware 
changes to apply changes. 

Open the NI Max application and expand the Devices and Interfaces section and verify 
the COM port number updates for your device. 

NI Serial Module COM Port Binding 

Configure NI Serial Module COM ports to be consistent with your system design if the 
System Verification operations reports a COM port number assignment error. Read the 
following instructions for information on how to correctly assign an NI serial module 
port number. 

1. Run the NI MAX application as an administrator by right-clicking the application 
shortcut and selecting Run as Administrator. You must run the application as an 

Note When swapping COM port number assignments between two 
ports, set one of them to an unused port number first to avoid setting two 
ports to the same port number. 

Note If you get an error when changing the COM port number, reboot 
the machine and try again. 

Note These final steps are necessary for your new COM port number 
bindings to be visible to Test System Maintenance Software. 
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administrator to enable COM port number changes. 
2. Select the COM Port you want to update. 
3. Click on the Advanced tab. 
4. Change the COM port binding from the COM Port Number drop-down list. 

Save changes by clicking File » Save. 

Environment Reference 

Test System Maintenance Software UI consists of a single window containing a File 
menu, Help menu, Home page, Report page, and Settings page. 

File Menu 

The File menu contains the following options: 

• Open Report Folder...—Opens a directory of previously generated reports. 
• Exit—Exits the Test System Maintenance Software. 

Help Menu 

The Help menu contains the following options: 

• Test System Maintenance Help...—Launches the Test System Maintenance 
Software Help. 

Home 

The Home page contains the following information: 

Note When swapping COM port number assignments between two 
ports, set one of them to an unused port number first to avoid setting two 
ports to the same port number. 

Note If you get an error when changing the COM port number, reboot 
the machine and try again. 
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• Recent Maintenance History — A list of links to the most recent reports created. 
• System Information — Details about your system. 
• Run Maintenance — Configure your system maintenance operations. 

◦ Maintenance Operations — Click the Gear button to select which maintenance 
operations you want to perform on your test system. 

◦ Run Operations — Click to run the selected operations. 
◦ Component List — Click the top box to run maintenance operations on all 

components or select individual components from the list. 

Reports 

The Reports page contains the overall result of operations run on your test system, as 
well as information on system configuration, system components, and detailed 
information about each operation run. 

Settings 

The Settings page contains information about Test System Maintenance Software. You 
can also use this page to configure settings like the number of reports stored, naming 
of test system components, and configurations of switch terminal block components. 

© 2025 National Instruments Corporation. 
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